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Mapping this talk...

Finding and downloading spatial data from
the USGS Seamless Server

Viewing data layers in Global Mapper (GM)
Measuring features in GM

Adding features to GM

Overlaying geology maps



« Seamless Data Distribution System - Windows Internet Explorer

Google |G~ v Goodd B - | ¥9 Bookmarks~ Ei Popups oka\}-é ¥ Check = \Autolink -

w o Seamless Data Distribution System |

v &Y ; < USGS Home
H ; L Contact USGS

science for a changing world Search USGS

‘What this Site Offers:

« Free Data Downloads

« User Defined Datasets and Area

« Acquire Data From Different Hosts
« Elevation Point and Profile Tools
« Tutorial

« and much more...

View and
Download

Syste’m Status:

The Seamless Data Distribution System is running.

Posted D6-26-2007: We are currently experiencing intermittent
problems with downloads requested in BIL and GridFloat formats. The
problem is being investigated by our staff. Since the problem is View and Download

intermittent, please try your request again if you experience a International Data
problem. A more long-term fix for these format problems is currently in
development. We apologize for any inconvenience. Thank you for your
patience during this time.

News:
Latest Announcements (updated 08-7-2007)

+ New Delivery Method -- Tiled Data Distribution System

{TDDS) Starting August 7, 2007, a new delivery method called Tiled Data
Distribution System (TDDS) was released for accessing historical imagery.
The concept of SDDS is to provide access to the "best available" geospatial
data. In the case of High Resolution Orthoimagery data, there are saveral
generations of imagery available. The older "historical” data for High
Resolution Crthoimagery will be migrated from SDDS to TDDS. TODS allows
access to the original tiles or chips of imagery from EROS storage systems.
The download includes a zip file containing the images files, metadata, and
index. There is @ new button under the Download section on the left side of
the viewer. Refer to the TDDS Tutorial for instructions pertaining to this
delivery meathod.

The list of data available for TDDS is within the "Products" droo down on the

Access GIS data
at
http://seamless.
usgs.gov/

Be sure to enable pop ups!

Internet Explorer has some
additional “security”
features to overcome when
it’s time to download
data...



Upon clicking N. America, you will
zoom to this view. Drag a box to zoom.
Note the tools in the icons at left

< Seamless Data Distribution System Viewer - Windows Internet Explorer

o~ |® hitp: /fseamless usgs.gov fviewer hitm

v || #] | x 2
Google |[Gl+ v Goo@ B~ 9% Bookmarks~ |2 Popups okay | ¥ Check » s AutoLink - (= Send to (D Settings~
i & | @ Seamless Data Distribution Systern .. fi- B @ - [ZPage~ @Tools~

Seamless Data Distribution (returntostart page) Tutorial

Scale Information

s ,_,_;.
Out IIIIIII““““ £
Scale ~

Display

p Places (Names)
p Layer Extent

) Structures

p Transportation
’ Boundaries

p Hydrography

p orthoimagery
p Land Cover

p Elevation

The visible layers can be
controlled at right
under “Display”




Click download button (lower left)
Drag the area of interest

=
@ 2 v |8l http: //seamless.usgs.gov fviewer htm v [[+2]x
Google |G- v Goea B~ ¥ Bookmarksy | B Popups ok g (O Settings~
& USGS Seamless Request Summary Page - ...
| @) Seamless Data Distribution Systern ... i - = - [rPage v i Tools v

http: ffextract cr Lsgs.gov/\Website /disteq/RequestSummary . jsp ?AL =42 .5300¢ v

=US
Seamless Data Distribution System

SDDS Request Summary Page

You are logged in as Default Seamless User.

ify Data Request_ || Tutorial _|__HELPL ]

Seamless Data Distribution (returntostartpage) Tutorial

r

Scale Information
-

Display
) Places (Names)
p Layer Extent

p structures

) Transportation
) Boundaries

) Hydrography

p Orthoimagery
p Land cover

) Elevation

Data Extraction Request Piece:

Output Parameters Links

National Elevation Dataset (NED) 1 Arc Second
v
2ZUSGS
Output Format: ArcGRID

NAD L EROS Data Center

X cel

Lol a7 U.S. Department of the Intenor || U.S. Geological Survey || EROS Data Center

: M URL: hitp:/fexiract. cr.usgs.gov/Website/distreq/RequestSummary. jsp
y awrr " "N Maintainer:pw apping@usgs.gov || Cemmenis and Suggestions
4 ;,",-J” _ir“rr |l Last Modified: Wed 13 Apnl 2005

‘d 4 Privacy Statement || Disclaimer || FOIA || Accessibilify

Default data set is a DEM.
_ izl o Click “modify data request”
Click and drag to ele aeato dcnload . for more---

& Internet + 100%



Select your data from the dozens
of data types...

”B le ] _]l

@ o v Ehtp: ffseamless Lsgs.gov/viewer htrm X P
Google G~ v Goos B - ¥¢ Bockmarks- |EhPopups ckay | (O Settings~
http: ffextract cr usgs.gov,/Website/distreq/RequestOptions jsp ?AL =42.53008170184556,42.4503750C +
4 | B Seamless Data Distribution System ... Al e - [5rPage v G Tools »

ZUSGS
Seamless Data Distribution (return tostart page) Tutorial Seamless Data Distribution System
SDDS Request Options Page

HELP!
Displa
Order Options: =

) Places (Names)
Output Coordinate System | Native + \ ) Layer Extent

p Structures

: p Boundaries
100k DRG - UTM Zone 18 Not selected. b Hydrography
p orthoimagery
: p Land cover
250k DRG - UTM Zone 18 Not selected. 55F! ) Elevation

Scale Information

|

[<]

24k DRG - UTM Zone 18 GeoTIFF | | ZIP v | HTML |+

ARMI - Ecoregions (USEPA, Level I1I) Mot selected.

ARMI - Land Ownership Mot selected.

ARMI - National Wildlife Refuge Boundaries Mot selected.

ARMI - National Wildlife Refuge Locations Mot selected.

ARMI - Natl Inventory Dams - 2005 Mot selected.

ARMI - North American Ecoregions (USEPA, Level 1) Mot selected.

ARMI - North American Ecoregions (USEPA, Level 11) Not selected.

ARMI - NPS 2007 Park Boundaries Not selected.

ARMI - LS. Mine Locations - 2005 Not selected.

Bureau of Transportation Statistics (BTS) Roads Not selected.

DOoQQ 1.0m B&W - UTM Zone 18 Not selected.

DOQQ 1.0m Color - UTM Zone 18 Mot selected.

FEWS NDVI Mot selected.

FEWS RFE Mot selected.

LANDFIRE 13 Anderson Fire Behavior Fuel Models Mot selected.

Click and drag to select area to download

LANDFIRE 40 Scott and Burgan Fire Behavior Fuel Models Mot selected.

(o o o O O

LANDFIRE Aspect Mot selected.
& Internet

o
=
=)
m



Select your data, and click “Save Changes and

Return to Summary” (bottom of dialog page)
_ (3%

@ ¥~ http: /fseamless usgs .govfviewsr Atm
Coogle [C» v Goos B~ | ¥% Bookmarks+ |BhPopups okay|

USGS Data Extraction Options Page - Windows Internet Ex
Bl hitp: /fexdract or usgs.gov/Website/distreq/RequestOptions. jsp AL =42 530081 701534556,42 45037500 +

o |l Seamless Data Distribution Systern ... Al E #m - |5 Page v & Tools »
National Atlas Vegetation Growth - Peak: 1999 Not selected.

|

Seamless Data Distribution (returntostart page) Tutorial National Atlas Vegetation Growth - Peak: 2000 Not selected.

National Atlas Vegetation Growth - Peak: 2001 Not selected. X
Scale Information

National Atlas Vegetation Growth - Peak: 2002 Not selected. £ : ||||||IIIII||||“
- 1]

National Atlas Vegetation Growth - Peak: 2003 Not selected. / Scale ~ 1:741,882

National Atlas Vegetation Growth - Peak: 2004 Not selected.

Display
National Atlas Vegetation Growth - Peak: 2005 Nat selected. i ) Places (Names)

National Atlas Volcanoes Not selected. ! ’ Layer Extent
. 5o ) Structures
National Atlas Waterbodies Nat selected. ) Transportation

(o o o

) Boundaries

) Hydrography
National Elevation Dataset (NED) 1 Arc Second ArcGRID ¥ HTML |+ : p Orthoimagery
P Land Cover

) Elevation

National Atlas Wilderness Preservation System Areas Not selected.

&

[

National Elevation Dataset (NED) 1/3 Arc Second ArcGRID |+ HTML |+

MNational Elevation Dataset (NED) 1/9 Arc Second Not selected.

National Land Cover Dataset 1992 - Land Cover Not selected.

MNational Land Cover Dataset 2001 - Canopy Not selected.

MNational Land Cover Dataset 2001 - Impervious Surface Not selected.

National Land Cover Dataset 2001 - Land Cover Not selected.

Orthoimagery - Central New York - 1.0 ft Color 2003 Not selected.

Orthoimagery - Eastern New York - 1.0 ft Color 2005 Not selected.

Orthoimagery - Eastern New York - 2.0 ft B&W 2004 Not selected.

Orthoimagery - Eastern New York - 2.0 ft B&W 2005 Not selected.

SRTM 1 arc sec - Shuttle Radar Topography Mission [Finished] |Not selected.

a
a
a
a
[
a
a
Ll
L]
[l
a

SRTM 3 arc sec - Shuttle Radar Topography Mission [Finished] |Not selected.

5.
Maximum size (MB) per piece i

Click and drag to select area to download Cancel All Changes & Return to Summary Save Changes & Return to Summary

- |

& Internet



Now, press the Ctrl key, and click
Download

(]

Ko v | Bhtip:/fseamless.usgs.gov viewer Hm X

Y - S Seamless Request Summary Page - Windows Interne.. =

Google [Gl» v Goes B~ | 9% Bookmarks~ |2 Popups okay | ¥ @ Seftings~
http: /fextract cr usgs gov/\Website/distreq/RequestSummary jsp?AL=42.53008170184556,42 450375 v

v 4w @) Seamless Data Distribution System ..

= = - sFPage » O Tools -

-
&USGS
Tutori Seamless Data Distribution System

SDDS Request Summary Page

You are logged in as Default Seamless User.

Seamless Data Distribution (retur to start page)

Display
p Places (Names)
Data Extra:

i p Layer Extent
Output Parameters Size (MB) || Download Links o

P Structures
24k DRG - UTM Zone 18 p Transportation

(WGS 84) P Boundaries

p Hydrography

p orthoimagery

74 : j P Land Cover

4384 Meters i [l p Elevation
Meters

EROS Data Center

rmat: ArcGRID
araphic

¥ cell . Download

US. Department of the Interior || U.S. Geological Survey || EROS Data Genter
URL: hitp:extract er.usgs. gow/Website/distreq/RequestSummary.jsp
Maintainer-webmapping@usgs.qgov || Comments and Suggestions

Last Modified: Wed 13 Apnl 2005

Privacy Statement || Disclaimer || iA |

Click and drag to select area to download

Accessibility

Done € Internet



Once the File Download window pops up, Save
the file (release the Ctrl key once Save is clicked)

}@7 LZL"']_ﬂI

&F 0 v B htp: fseamless. usgs.gov viewer hitm

Y a1 % pl-

= = 2 - |O/X]| —

Google [Cl+ v Goo@ B v | & Bookmarks~ B Popups okay| 9 () Settings~
hittp: ffextract.cr usgs .gov/\Website/distreq/RequestSummary  jsp 7AL=42,53008170184556,42.450375 + ||

W Seamless Data Distribution System g ; = K # - [EhPage v & Tools +

]

Seamless Data Distribution (retur @. Bl http: fextract.cr usgs.gor V1| 4o [ %

Google [Cl+ v Gorg B~ 9% Bookmarksw > (D) Seftings~ ES @ Scale Information
'8 J

e e i
O et "

Display

E £ Places (Names)
Raster Extract has completed. Iz ;Layer A
P Structures
p Transportation
P Boundaries
P Hydrography
p orthoimagery
P Land Cover
P Elevation

This window can be closed after saving the file.

U S Department of t!

el e File Download

sgs.goviWebsite\mai

Last Modified: Fri 28 June 2002 Do you want to open or save this file?
Prvacy Statement || Disclaimer

Mame: 84133875.2ip
Type: Compressed (zipped) Folder, 1,26MB
From: 152.61.128.18

[ Open ] [ Save ] | Cancel |

&, Start downloading fror

a7

Always ask before opening thiz tppe of file

While files from the Intemet can be uzeful, some files can patentially
harm pour computer. IF you do not tust the source, do not open or
save this file. What's the risk?

EROS Data Center

r || US. Geological Survey || EROS Daia Center
Click and drag to select area to download URL: http:/extract cr.usgs gov/Website/distreq/RequestSummary.jsp
Maintamer.webmapping@usgs.gov || Comments and Suggestions
Last Modified: Wed 13 Apnl 2005

Privacy Statement || Disclaimer || iA || Accessibility

& Internet



Open Global Mapper
Click “Open your own Data Files”

£ Global Mapper - REGISTERED

File ‘Wiew Tools Search GPS Help
| el (B == |ng| [ 20]oom| @[] ||| TookrRamsShaer =] (] Za

[ Open Your Own Data Files

(Menu Command: File->Open Data File)

# Find Data Online @

(Menu Command: File->Download Daia)

Download Free U.S. Maps and
Imagery from TerraServer

(Menu Command: File->Download TerraServer Inagery/Tope hMaps)

|eZ Display Settings/Projection

(Menu Command: Tools->Configuration)

@ Manage l.oaded Data

(Menu Command: Tools->Conirel Center)

Files from the USGS often arrive zipped.
Global Mapper does the unzipping, so don’t bother unzipping the files,
just open the files from within Global Mapper




Voila! We can now visualize...

=/Global Mapper - REGIST
File View Tools Search GPS Help

=888 @ae|u [ ofm=]e]am]¥]a]] Fermwme = Ez)

0.5 km 1.5km 25km

Height = 538.6 meters (DEM-10M.ZIP) | 42.5061650 N, 75.062198° W

iJstart '™



tions...

Check out your op

% Global Mapper - REGISTERED
N Wiew  Tools Search GPS Help

Cpen Data File(s)...

Cipen Generic ASCIT Text File(s). .
Cipen All Files in a Directory Tree,,,
Cipen ECW File from the Web. ..
Unload All...

Chrl+0 Color Ramp Shader = |

Crl+U

Create MNew Map Catalog...
Download Data from the Web. .

Download Terraserver Imagery/ Topo Maps...

Load Workspace. .
Save Workspace. ..
Save Workspace As...

Cirl+w
Cirl+5

Fun Script...

Capture Screen Contents to Image...
Export Global Mapper Package File...
Export Raster and Elevation Diata
Export Vector Data

Batch Corwert/Reprodect. .

Generate Contours. ..
Rectify (Georeference) Imagery...

Print...
Print Preview ..
Print Setup...

Cirl+P

1 CHDEMEY,. Ndem-10m.zip

2 Milford Canyon warkspace.gmw
3 SilverCreek-GIS-workspace grmw
4 CADEMS,, . \NED_test-30m.zip

Exit

Clrl+x

-
iy

start

[GED (WADE3) - {-75, 10493846, 42.53171403 ) |42.531714° N, 75.104988% W

Search Desklop

.01 PM




Generate contours

Global Mapper - REGISTERED

File View Tools Search @RS Help

@|ﬂ|g|@‘ & | e e ne) |H§";'|m|qs|‘j\g|gﬂ|‘ [Color Ramp Shader _~

-~ Cortour Interval

[0 METERS ]

I Only Generate Contour Lines at Specified Height

~ Resolution
The resolution affects fidelity with which contours are
generated. Larger numbers result in less detailed contour
lines that take up less space. Typically vou'll just want to
accept the defaults.

Havis |9.2992992600000  aic degiees
f-awis |9.2592592600004  aic degiees

If wou wish to change the ground units that the resolution
iz specified in, pou need to change the current projection
by going to Config-»Projection.

o Generate Area Features Colored Based on the
Current Elevation Shader in Addition to Contours

[~ Generate Spot Elevations at Min/Max Elevations
¥ Interpolate to Fill Small Gaps in Data
¥ &ppend Unit Labels ['m' or 'ft'] to Elevation Labels

ok I Cancel Apply

0.6 km 1.8 km 2.8 km

For Help, press F1 |GED (NADB3) - [-75.10136512, 42.53078497 ) |42,530785% N, 75.101365° W

Bl eaich Desklop £y~ ]




Configuration tool: note the tabs

</Global Mapper - REGISTERED

File  View Tools Search GPS Help

@lnlgl@” Qlalﬁlgl Eé"’?lml%l’él\glgﬂl‘ IEoIorHampShader - ﬁ.&”

4708000 m

Configuration X Y
Eoacdl || e Area Skl T i 1 1 1
T e Projection tab permits

frorcion Load From File...
S Save ToFile. you to Change all of the

L]:nE:r‘SW - 72" - Marthern Hemisphere] ;i iR e o | aye rS to a n eW
X . | coordinate reference

|METERS

| | frame—UTM in this

Atribute:

P

o
5 K3
i) oK I Cancel Apply
~p
-
§a
%
g
I ! ! ! ! 1 1 1 4700000 m g
I T T T T T T 1 %
0.5 km 15 km 25 km 3.8 km L
For Help, press F1 |GED (HADE3) - (-75.10238709, 42.53199274 ) [42.531993% N, 75.1023877 W

s start B Broy 2ag Se... B ] : i t P Pl o Sl -ich Deskiop &)@ 5:.04PM




3-D Perspective viewer

0.6 km

For Help, press F1 |GED (MADB3) - (-75.07739537, 4253199274 ) 42.531993° N, 75.0773957 W

"% start



Full screen 3-D

it ®Q 2k =hin B

u—,'; start [ BrownBag Se.. | @MicrosoftPow.. | % Global Mappe... ™8 3D view P 4%.2_; T




Profile Tool

%+ Global Mapper - REGISTERED

File Wiew Tools Seach GPS Help

ﬁ"lnl.lﬂ Qlalﬁlh—el ﬁ@lml&ﬁflzﬂl IDayI\ghlShader - IEH

= Path Profile/Line of Sight
File Cptions  Calculate
From Pos: -75.04782028, 42.48277835 To Pos: -75.03336823, 42.48120928

560 m — -

~ Profile data can be saved to a

525m—- -

- text file, then imported into Excel -

R ———__—_——

Line of Sight... Cut-and-Fill Yolumes..

Left click to add points, right click to finish, |GED (NADSS) - ( 7503336923, 42,48120028 ) |42.481200
71 Sta!’t . [ off e ZCEl 7] 'f' Search Desktop




Measure Tool

< Global Mapper - REGISTERED
File Wiew Tools Search GPS Help

z|a|eE &2 el oo e |mw Y |s| e <

Measure
areas J I I n e Close Po\yggm and Stop Measuring
lengths, etc | 2 e

Always Display Base Units (Meters or Feet)

350 m

Measure Volume (Cut-and-Fill)

Save th e : IUze Metric Distance Units

Lze Mautical Distance Units

m eaS U re m e nt Use Statute Distance Units

Ise Acres For Area Units

aS a. VeCtor Use Hectares For Area Units

Use Square Feet For Area Units

Ia er { v Use Square Kilometers For Area Units
y Lo U Square Meters For Area Units

Use Square Miles For Area Units

20

0.0 km 0.5 km 1.0 km 15 km 20km

Seq Len: 870 m, Seq Brg: 216.9°, Taotal Len: 7.44 km, Enclosed Ar ‘GEO (NADE3) - { -75.06536920, 42.47281676 ) |42.472Ell7° M, 75.065360° W

‘s start ™ &ownBage. [ @Microsot img S <




Clicking the Info icon, then clicking a feature,
highlights the feature

% Global Mapper - REGISTERED
File ‘Wiew Tools Search GP5 Help

(B8 R e(x| Q|0|wm/e ws] g Fese ][5 G

m Feature Information |X|

Mame: I'MU m

Description: IEontaur Line. binor

Geametry: |7nsa verices, Length 31 km

Map Name: IGENEHATED COMTOURS

Right click on an entry for mare options [i.e. open URL, ete.]
Attribute ! Walue |

Edit Feature. Delete Feature Copy to Clipboard

You can edit
the feature

Highlighting a \\
contour can
help identify
terraces at

same height

40

0.0 km 0.8 km 1.0 km 168km 2.0 km 2.8 km

<440 m> Contour Ling, Minar - iHeight = 441.0 meters - DEM-10M.ZIF)

=0 - il oot Deskion m %,



Or, you can flood an area

Global Mapper - REGISTERED

File  WView Tools

ach GPS  Help

|0 @|E| &|®|o|k| Qv (a6 Fre <l E

Configuration

General | Vector Displap | Area Styles | Line Stules I
Point Styles  Wertical Options | Shader Dptions | Projection

¥ Enable Hil Shading
~Elevation Display Unit

@ Native Overlay Units " Metic Statute [ft) |

Light Direction

Altude [45 — Azimuth 145 = ‘

Ambient Lighting (0.00)—————
Dim J— Bright ‘

[ Wertical Exaggeration (08)

Flat li High ‘

“water Display

IV Show water on Elevation Data water Color.
Wiater Level 430 IMelels - I

W ater Transparency (78]

350 m

Clear  — |— Opaque

ok | cemeel | eeeb |

I 1
0.0 km 0.4 km

I 1
1.0 km 1.8 km 2.0 km

For Help, press F1

‘s start

‘GEO (MADBE3) - ( -75.09621400, 42.51053661 ) |42.5105379 M, 75.006214° W
o



Adding GPS data

< Global Mapper - REGISTERED
View Tools Search GPS Help
Open Data Fila(s)...
Cipen Generi 1I File
Open All Files in a Directory Tree...
Open ECW File from the Web...
Unload All... Cirl+U

Atlas Shader

Create New Map Catalog. ..
Download Data from the Web, .
Download TerraServer Imagery/Topo Maps...

Load Workspacs, . Cirl+w
Save Workspace. Cirl+s
Save Workspace As...

Run Seript. ..

Capture Screen Contents to Image. .

Export Global Mapper Package File...

Export Raster and Elevation Data 14
Export Wector Data 4
Batch Convert/Reproject...

Generate Contours...
Rectify (Georeference) Imagery...

Print... Cirl+P
Print Preview. ..
Print Setup...

1e_03391324_12_07200_col_2001 sid
2 SilverCreek-GIS-workspace gmw

3 CHDEMSY, . \dem-10m.zip

4 drg-24k.zip

Exit

Open generic ASCIT text file(s) with coordinate/attribute infor mation SE4) - ( 494520.666, 4702190.960 ) |42,472043° N, 75.066547° W

start nE & Mi

JuTM (i
3 (7] 'f' Search Desktop



Rectifying a
geologic
map...
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Manual image rectification

Image Rectifier (VENTURA-GEOLOGIC-MAP.PNG)

File Options
Entire Image Zoomed Yiew (Click for Pixel Coordinates] Reference Images [Load into Main Wiew First]
3804000 m
3800000 m
8 g g
= o ol
= =1 =1
= =1 =1
=T (=) o
ca =
=} 3] &

Ground Cantrol Paint [GCP] Entry Ground Control Paint [GCP] Projection
Pizel3e [T #/Easting/Lon |0 Add GCP to List Geographic [Latitude/Longitude] / WiGS84 / arc de
Pisely |0 ‘réMorthing/Lat |0 Update Selected GCP Select Projection

Errar Delete

Ground Control Points [Double-click to Center on GCP]
Paint Mame | Pixel? | Pixel ¥ | Projected | ProjectedY | Longitude | Latitude
Canicel
Help

g

292000 m

283000 m

I I 1
0.0 km 0.5 km

UTH (NAD27) - { 281537782, 3802339.008 ) |34.341119° M, 119.374878° W

1.0 km 1.5 km 20km 258km

For Help, press F1




Zoom in to an area, select points common in both
layers (DEM at right); Need 2 points for rectification

mage Rectifier (VENTURA-GEOLOGIC-MAP.PNG)

File Cphions
Znomed Vlew [Click: for Pixel Cooldmates] Reference Images [Load into Main Yiew First)

Entire Image

3800000 m

3796000 m

284000 m
288000 m

Ground Control Point [GCP] Prajection -

Ground Contral Paint [GCP) Entry
Pixel [0 %/ asting/Lon |0 Add GCP ta List Geographic (Latitude/Longitude) /WG58 / arc des
Pirely |0 */Northing/Lat |0 Update Selected GCP Select Projection ...

Ground Contral Paints (D ouble-click ta Center on GCP]
Foint Mamne | Pixel | Pisel | Projected | Projected ' | Longitude | Latitude Error Delete -
Cancel
Help




Topo + Geo => virtual landslide investigation

= Global Mapper - REGISTERED (Ventura-Geology-topo-workspace.gmw)

File Wiew Tools Search GPS Help
alo(E] «2olk| Blol=lefs k(e e < Eal B

S B 3 AN AU AT
I \)l\% [ = Path Profile/Line of Sight
el

File Options Calculate

From Pos: 204418.639, 3797500.927

3300000 m
| Qhpr

3786000 m

aQhty

292000 m

1 1 I 1
0.0 km 0.5 km 1.0 km 15 km 20km 25 km

Left click to add points, right click to finish,

; start | ™ Ventra






